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Technical Support
If you have difficulties using Express Scribe Transcription Software please read the applicable 
topic before requesting support. If your problem is not covered in this user guide please view 
the up-to-date Express Scribe Transcription Software Online Technical Support at 

www.nch.com.au/scribe/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to Express Scribe Transcription Software, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nch.com.au/scribe/support.html
www.nch.com.au/suggestions/index.html
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About Express Scribe
Express Scribe is professional audio playback control software designed to assist the 
transcription of audio recordings. It is installed on the typist's computer and can be controlled 
using the keyboard (hot-keys) or foot pedals.
Express Scribe can be used to play and transcribe recordings and videos in a variety of 
formats, and includes its own Dock feature to transfer recordings directly from portable 
recorders. 
Dictations can be recorded in several of NCH Software's applications: 

Express Dictate: Professional Dictation Recorder 
http://www.nch.com.au/express/index.html  
MSRS: Conference and Court Recording System 
http://www.nch.com.au/msrs/index.html 
Web Dictate: Internet Dictation Software 
http://www.nch.com.au/webdictate/index.html 
Dial Dictate: Phone Dictation System  
http://www.nch.com.au/dialdictate/index.html 
Pocket Dictate: Voice Recorder for iPhone, Pocket PC, or Palm OS  
http://www.nch.com.au/pocket/index.html  
Express Scribe features foot pedal or hot-key control, variable speed playback, automated 

dispatch of typed documents and can work with speech recognition to assist transcription.
You can type using any Windows word processor including Microsoft Word, Corel 
WordPerfect, Lotus Word Pro and others while Express Scribe runs in the background. 
Alternatively, you can use the Express Scribe Notes Field. 
System Requirements 
● Windows XP / 2003 / Vista / 2008 / 7 / 8 / 10 
● Sound Card
● Speakers (or Headset)
● [Optional] Foot Pedals
● [Optional] Internet Connection (to receive recordings via the internet)
● [Optional] Computer Network (to receive recordings over the network)
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Licenses and the Trial Period
Feature Comparison Table 

Feature  Express Scribe Express Scribe Pro 
Supported file formats AIFF, DCT, MP3, WAV, WMA All compatible file formats
 Supported foot pedals AltoEdge USB Foot Pedal All compatible foot pedals
Video playback No Yes
Licensed for Home  

● Home
● Small business (fewer than 

10 staff)
● Corporate / enterprise / 

government

Technical support available No Yes
 
Trial Period  
Express Scribe will operate as a trial version for a limited time after it is first installed. During 
this trial period, all features of Express Scribe Pro are available. When the trial expires, you 
must purchase a license from the secure, online purchase page to continue using the 
advanced features of Express Scribe Pro. 
For activation and registration instructions, please refer to 
Technical Support - Purchasing and Registering Licenses . 
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Common Tasks
File Management  

Load Files 
There are three ways to load recordings or videos into Express Scribe: by syncing with a 
folder to automatically check for new files, by manually selecting a file, or by transferring a 
file from a transcription device.
Sync:  
Set up Express Scribe to sync by clicking the Sync icon from the main toolbar. This takes 
you to the Incoming tab of the Options window (see Options ~ Incoming). Once Express 
Scribe is set up to automatically load recordings, it will check for new files regularly while it 
is running. 
Load:  
If you need to load recordings or a video into Express Scribe manually, press Ctrl+L or click 
the Load icon from the main toolbar. Browse to locate the recording or video files using the 
file field, or the browse and folder icon buttons to the right of the file field. You can load 
multiple files at the same time by holding down the shift key while selecting files. 
For files received on CD-ROM, refer to the Loading Files from a CD section of this user 
guide. 
Load and Delete Dictation Files (Ctrl+Shift+L): 
This is the same as loading a file except that it deletes the original file after loading. This is 
useful if you are loading recordings one at a time from a shared folder to ensure that no one 
else loads the same file after you have.
Auto File Transfer: 
You can load files directly from a handheld recorder using the Dock icon in the main toolbar. 
See the Transfer from Portable Handheld Recorders - Dock section of this manual for 
instructions. 
Completing a Dictation  
When you have completed the typing for a file, you can either Dispatch the typing by email 
to the person who dictated the file or you can simply mark the file as Done. Either action will 
remove the file from the active files list.
To Dispatch the selected file by email, press Ctrl+D or click the Dispatch tool-bar button. If 
you have typed the document using a word processor (e.g., Microsoft Word), you can 
attach the word processor file to the email (click Browse). 
To mark the file as Done without emailing it, press Ctrl+N or click the Done tool-bar button. 
Recovering a Completed Dictation 
To recover an old dictation to amend the transcription file, open the "Recover Old 
Dictations" window. Do this by clicking the double-arrow icon in the secondary toolbar, or 
press Ctrl+R. The window will display files that have been Dispatched or marked as Done. 
Files will be automatically deleted from this list after 1 month. Note that only dictations that 
have been Dispatched or marked as Done can be recovered. Dictations that have been 
deleted cannot be recovered. 
Delete File  
To delete a file press Ctrl+Delete or click the Delete icon from the secondary toolbar, and 
then confirm that you wish to delete the file. Deleted files cannot be recovered. We 
recommend you mark files Done instead, as described above. 
Save as DCT  
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You can save the current material (including the associated Word Processor document) as 
a DCT file so it can be loaded by another typist. This is useful if you are halfway through 
typing and want to forward your work to another typist. Be sure to save your wordprocessor 
document before selecting this option. Save as a DCT file by clicking the disk icon in the 
secondary toolbar, or by selecting File->Save as DCT.
Forward to... 
Forward the recording (and any attachments) to another person by email, network or 
internet by pressing Ctrl+Shift+F or by clicking the Forward To icon from the secondary 
toolbar. See the Forwarding Files section for more information. 
Controlling Audio and Video Files 

Play (F9) 
To play the selected file at the currently set speed, press F9 or press the Play button in the 
control section at the bottom of the Express Scribe window.
There is a speed adjustment slider to the left of the play controls along the bottom of the 
Express Scribe window which allows you to speed up or slow down the recording. 
Alternatively, you can press F11 to play at slow speed, F3 for fast speed or F10 to return to 
real speed. The slow and fast speed can be set using Options ~ Playback. 
Stop (F4)  
To stop press F4, or press the Stop button in the Control section on the bottom of the Express 
Scribe window.
Movement within the recording (F7, F8, Ctrl+Home, Ctrl+End, Ctrl+J) 
To rewind or fast-forward, click and hold down the Rewind or Fast-forward buttons in the 
Control section on the bottom of the Express Scribe window.
To move to the start directly, hold down the Control key and press Home. To move to the end, 
press Ctrl+End.
You can also quickly move around the file using the scroll bar in the Control part of the Express 
Scribe window.
To jump to a specific time in the recording press Ctrl+J. A dialog will appear prompting you to 
enter the elapsed time you wish to jump to.
Foot pedals or system-wide 'hotkeys' can also be used to control Express Scribe. For more 
information see Controllers ~ Overview and About System-Wide Hot-Keys. 
Typing 
You can type using any Windows word processor including Microsoft Word, Corel 
WordPerfect, Lotus WordPro and others while Express Scribe runs in the background. 
Alternatively, for small amounts of text, you can type into Express Scribe's Notes window and 
then copy and paste the text into another document. 
If you use a word processor, you should use system-wide hot-keys so that Express Scribe can 
be controlled while it is in the background. Alternatively, you can use a foot pedal controller. 
For more information, see About System-Wide Hot-Keys or Controllers ~ Overview. 
If you don't use the Notes window, you can hide it by unticking View -> "Show Notes Window".
See also:
Keyboard Reference 
Options ~ System-Wide Hot-Keys 
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Keyboard Reference
Keyboard Short-Cuts  
F1 Display Help
F2 Rename File
F3 Play Fast Speed
F4 Stop
F7 Rewind
F8 Fast Forward
F9 Play
F10 Play Real Speed
F11 Play Slow Speed
F12 Play (with Pausing)
Ctrl+Home Go to start of dictation
Ctrl+End Go to end of dictation
Ctrl+Delete Delete File
Ctrl+K Copy All (Notes Field)
Ctrl+B Set Bookmark
Ctrl+Shift+B Open Bookmark List
Ctrl+Left Previous Bookmark
Ctrl+Right Next Bookmark
Ctrl+C Copy (Notes Field)
Ctrl+Y Sync Files
Ctrl+D Dispatch File
Ctrl+H Attach a File
Ctrl+J Jump to Time
Ctrl+L Load File
Ctrl+Shift+L Load and Delete File
F1 Display Help File
Ctrl+M Show Express Scribe Mini Control
Ctrl+N Done
Ctrl+R Recover Old Dictation(s)
Ctrl+Shift+T Insert Audio Time
Ctrl+U Open default word processor document
Ctrl+V Paste (Notes Field)
Ctrl+X Cut from Notes Field
Alt+F4 Exit Express Scribe
Ctrl+Shift+C Load Audio CD Tracks
Ctrl+I Dictation Information
Ctrl+Shift+F Forward Dictation
Ctrl+T Copy to Clipboard - Time
Ctrl+F Find
Ctrl+G Find Again
Ctrl+A Select All 

Recover Old Dictations Dialog
Ctrl+P Play
Ctrl+D Delete
Enter Recover
Esc Close
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 Dictation Preview Player
Space Play
Space Pause
Home Go To Start
Left Rewind
Right Forward
End Go To End
 
Default System-Wide Hot-Keys  
F3 Play Fast Speed
F4 Stop
F5 Open Express Scribe
F6 Minimize Express Scribe
F7 Rewind
F8 Fast Forward
F9 Play
F10 Play Real Speed
F11 Play Slow Speed
 
See also:
Options ~ System-Wide Hot-Keys 
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Loading Files From a CD
When Menu-> Load Audio CD Tracks is clicked Express Scribe will automatically detect any 
Audio CDs in all CD-ROM drives. The main display will list all track names and durations for 
the CD in the selected drive. Any time you eject a CD or load a new one, click refresh to 
update this display. 
Highlighting and selecting load will rip each of the tracks selected and load them into Express 
Scribe.
Please Note: 
● If Express Scribe does not detect any tracks on your CD, or the tracks have strange looking 

names, please verify your audio CD files have a .cda file extension. If they do not, then 
Express Scribe will not be able to properly read the audio files. In such situations, it is likely 
the files are stored as data on your CD, so you should be able to use  File Explorer to copy 
and paste the files from the CD to your hard drive. 

● There are limitations on ripping audio CD's on Windows XP when not logged on to an 
administrator account. See Enable CD Ripping/Burning for Restricted Users for more 
details. 

9

http://www.nch.com.au/kb/10008.html


Floating Windows
Floating a window above other windows forces it to always stay on top of any other open 
applications. When this option is enabled, you can keep Express Scribe visible while typing in 
a word processor. 
Select the View -> "Float Above Other Windows" menu item to enable or disable floating. 
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Scribe Mini
Scribe Mini is a small window extension of the main Express Scribe user interface. Clicking the 
Scribe Mini button in the main toolbar will minify the main Express Scribe window to contain 
just the controls and a video panel, providing video has been activated from View -> Show 
Video. Using Scribe Mini allows more room for you to see the rest of your screen if you are 
primarily working on a word processor and still need to refer to Express Scribe.
Any hot-keys, controllers, or foot pedals you use with Express Scribe will still function while 
Scribe Mini is in use.
You can switch to Scribe Mini by going to the menu View->Show Express Scribe Mini Control, 
or by pressing Ctrl+M. 
To revert Express Scribe back to its original size, click the 'Show/Hide Scribe Mini Control 
Window' button to the right of the play controls. Toggle back and forth between the screen 
views with the keyboard shortcut Ctrl+M. 
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Working with Word Processors
The Express Scribe Notes Field is not intended to replace your word processor. Express 
Scribe works well with Microsoft Word, Corel WordPerfect, Lotus Word Pro and most other 
major word processor software. You can either run both Express Scribe and your Word 
Processor at the same time or you can type the text in the Express Scribe Notes Field and 
then copy and paste it into your word processor.
Typing directly into your word processor 
After you have selected the file in Express Scribe, open your word processor. You then control 
playback with a foot pedal controller and / or system-wide hot-keys. 
To automate the creation, opening and management of word processor files. Create a base 
template doc file and save it in the folder where you want Express Scribe to store documents. 
Then tick the use base word processor document Options ~ Other and select that new file. 
Then whenever you want to open or create a document related to the recording, press Ctrl+U. 
If the document already exists it will be opened. If the document does not exist, Express Scribe 
copies the base file. 
Advanced Option: If you want to use a different base document depending on the type of the 
recording, you can include in the name of the base document fields circumfixed with the % 
character. When Express Scribe creates a document for the first time it searches first the notes 
for data (which could have been entered by the dictator using DialDictate or Express Dictate). 
If no data was entered by the Dictator using Express Dictate or DialDictate then it will prompt 
for the data now. For example, if your word processor base document is entered as C:\My 
Documents\Template%doctype%.doc then Express Scribe scans for <doctype>...</doctype> 
data and if not found prompts for the doctype. If say a DialDictate user had entered 21 for the 
dictation type it would have saved <doctype>21</doctype> and Express Scribe would use 
"Template21.doc".
Typing first into the Notes Field  
Alternatively, you can type the main body of the text using the Express Scribe Notes Field. 
Then press Ctrl+K to copy all the text, run your word processor and paste the text into a new 
document. 
Dispatching Word Processor Documents 
You can dispatch a word processor file as an attachment to the email you return to the person 
who dictated the work. When you click Dispatch, click on the 'Open Attachment List' button to 
locate the file.
See also:
Controllers ~ Overview 
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Attachments
Add, remove, and save as Attachment  
In Express Scribe you can attach additional files to the dictation. These files are then sent with 
the recording when you forward or dispatch the file.
To attach a file, right click the dictation you are going to send, and select "attach file(s)". Then 
browse to the folder where the file is kept, select it, and click open.
Express Scribe will now automatically send this file as part of your dictation.
See also:
Using Express Scribe with your Word Processor 
Forwarding Files 
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Word / Line Counter
Click Tools -> Word / Line Counter to count the number of characters, words, and lines in 
some text. 
If a dictation is selected when the counter is open, the text will default to the notes from the 
dictation, and the number of characters, words, and lines will be automatically calculated. 
Click Recalculate to re-count the number of characters, words, and lines if the text changes. 
e.g., After pasting text from another application. 
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Bookmarks
You can set bookmarks anywhere in the text which later enable you to easily to find the 
bookmarked positions. Maybe you want to mark positions where you did not understand the 
dictator clearly, or the position where another typist is to continue from.
Ctrl+B sets bookmarks, with Ctrl+Left; and Ctrl+Right you can move between the bookmarks. 
The pulldown "bookmark/open bookmark list", or Ctrl+Shift+B, opens a list of all bookmarks for 
the current dictation. There having ticked "prompt for comment when setting bookmark" you 
will be asked for a comment every time you set a new bookmark, later shown in the bookmark 
list. e.g. You want to enter: "Continue from here" or "Did you mean NIGHT or KNIGHT?".
Click the Remove button on the Bookmarks dialog to remove a selected bookmark from the list.
Note: The DCT file format does not currently support saving bookmarks.
See also:
Using Express Scribe with your Word Processor 
Forwarding Files 
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Tags
Received dictations can contain up to two tags, stored as XML data in the dictation notes. 
Each tag consists of a name and a value (i.e., <name>value</name>). Tag data is usually set 
when the recording is made. 
Tags are optional, and tag names and values can both be configured. How they are used is up 
to you. Some examples are: 

● For storing client or case numbers, to make them easily visible in the dictation list. e.g., 
<caseno>12345</caseno>. 

● For storing the language that a recording was made in, so Express Delegate rules can 
be configured to automatically assign dictations to a typist who speaks that language. 
e.g., <lang>French</lang>. 

Tags can be displayed in the dictation list on the main window by adding custom columns. 
See Options ~ Display for more information. 
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Dictation Information
Select one or more dictations then click File -> "Dictation information" to display the following 
information about the selected dictations: 

Number of dictations selected 
The number of dictations for which information is being displayed. 
Total duration 
The sum of the durations of the selected dictations. 
Time offset 
When the received dictation is only one part of a longer recording, set the time offset to 
adjust playback times to match the original recording. The offset is applied in both "time 
elapsed" and "recording time" time modes. For information on time modes, see 
Options ~ Display. 
Note: The offset can only be changed for one dictation at a time. 
Note: The offset is stored locally, per dictation, and is not saved in any exported or 
forwarded files. 
Sender 
The name and contact details of the user who sent the dictations. 
If the dictations were sent by different users, values will only be displayed for the fields 
that have the same value for all dictations. Fields that have values that differ for each 
dictation will show "[Various]". 
Note: 

● Sender details are only available when the sender entered their details before 
sending the dictation.

● Sender details are only available for dictations sent as DCT files.
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Forward Dictation(s)
This option lets you forward a dictation file via email, the computer network (to a folder) or the 
internet (using a FTP server). You can use this function when a dictation is only partially 
transcribed, and needs to be forwarded to another person for completion.
To forward a dictation, select it and press Ctrl+Shift+F. Then select the method you want to 
use to send the file or the location it needs to be sent to. If in doubt ask the person who set up 
the dictation system for you.
Any attachments to the dictation will be sent with the dictation. To attach a file press Ctrl+H 
and browse to locate the attachment.
Forward method 

Email attachment  
If you select this option, the recipient will be sent the dictation as a file attached to an 
email.
Enter the email address of the typist in the Email Address box.
See also: Email Settings 
Forward to folder on this computer or LAN (Local Area Network) 
If the recipient is in your own office the fastest way to send typing to them is over your 
computer network. You must have a shared folder on the network. If necessary ask your 
system administrator to create a suitable folder.
Enter the full name of the shared folder in the "Folder or Drive". For example, your 
shared folder might be "H:Typist". Please note your typist's software ("Express Scribe") 
must also be setup accordingly.
Upload to server (FTP) 
Express Scribe can send dictations directly to an internet server. This is faster than the 
email option but requires that your typist have access to a web hosting (FTP) service to 
store the files.
Select the Direct Internet Connection option and enter the Server, User Name, Password 
and Directory as setup for your FTP server for the typist you need to forward the file to.
Recommended Hosting Services 

Encryption 
Enable "Re-encrypt dictation" to encrypt the dictation before it is forwarded. This option can 
only be used if the dictation was encrypted when it was received. 
File name format  
The file name of the forwarded dictation can be specified using a combination of fixed 
strings and/or variables.
The available variables are:

● %dict-name%: Dictation name
● %dict-num%: Dictation number (0 if the dictation was not received from a sender)
● %sender-num%: Sender number (0 if the dictation was not received from a 

registered sender)
● %priority%: Dictation priority (3 digits, 000 to 100)
● %now-year%: Current date - Year (4 digits)
● %now-month%: Current date - Month (2 digits, 01 to 12)
● %now-day%: Current date - Day of the month (2 digits, 01 to 31)
● %now-hour%: Current time - Hour (2 digits, 00 to 23)
● %now-min%: Current time - Minute (2 digits, 00 to 59)
● %now-sec%: Current time - Second (2 digits, 00 to 59)
● %%: Percent sign (%)
(Note: The file extension .dct is appended automatically.)
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Example: For a dictation named "My Dictation" forwarded at 2PM on the 1st of January, 
2008, the format string 
"FWD-%now-year%%now-month%%now-day%-%now-hour%%now-min%-%dict-name%" 
would give the file name "FWD-20080101-1400-My Dictation.dct" 
See also:

Incoming File Options 

19

optionsin.html


Transfer from Portable Handheld Recorders - Dock
Express Scribe supports two methods to transfer recordings from a handheld recorder. If you 
have a digital handheld recorder that uses the open WAV file format and comes with its own 
connection cable and software you can use the Audio File Transfer Method. If you are using an 
analog microcassette recorder or a digital recorder that uses proprietary formats you can use 
the Audio Cable Method to record in the dictation.
Note: If you are using a PDA to dictate the easiest way to send and receive recordings is to 
install the free Pocket Dictate software from www.nch.com.au/pocket and use email to send 
the recordings directly to your typist. Then you will not need to Dock feature at all (the typist 
simply opens the attachment). 
See our website  for more information on recommended handheld recorders
Dock - Audio File Transfer Method 
Use this option if you are using a digital recorder that uses an open file format to record your 
dictation.
Your handheld recorder must come with software that will automatically transfer the recordings 
and place them in a folder on your hard drive.
Once you have set up your handheld software, using Express Scribe select File / Transfer from 
Portable (Dock) / Audio File Transfer Method then browse to the folder on your hard drive 
where the docking software of your handheld has been set to download the WAV files. In the 
Dock (Audio File Transfer) dialog, you also have three options for transferring your files:
● Load files from sub-folders Select this option to load files that are stored in sub-folders of 

the main folder you have specified.
● Delete files after loading  Select this option to delete dictation files from the folder you have 

specified.
● Only load files newer than those previously loaded  When this option is checked, only files 

with a modified date more recent than other files will be added. This option is convenient 
for people who continually make new recordings without deleting old ones, and will prevent 
Scribe from importing old files repeatedly.

Basic Record Instructions
The list of recorders below contains basic information for installing the recorder's software and 
setting up the recorder to dock with Express Scribe.

Philips Recorders 
These recorders work well with Express Scribe. You must install the software provided with 
the recorder on the computer running Express Scribe. Then you will be able to load the 
WAV files from the Philips recorders.
Sanyo Recorders  
You must install PCMemoScriber (from the CD-ROM supplied with the Sanyo Recorders) 
on the PC running Express Scribe. Using Express Scribe select File / Transfer from 
Portable (Dock) / Audio File Transfer Method then browse to the folder C:\Program 
Files\PCMemoScriber. Whenever you need to "Dock" recordings (1) from PCMemoScriber 
click on the "Transfer from Voice Recorder" button then, when download is complete, (2) 
click on the Dock button on Express Scribe.
Olympus Recorders - dss files 
Please refer to File Formats Technical Support  for notes on DSS file format support. 
Sony Recorders / Memory Stick Devices  
There is one additional step when docking files from Sony Recorders - using the Sony 
Voice editor to export to WAV files. This can be done very quickly once you know how.
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Open Sony Voice Editor program. Follow the normal process to load files from the recorder 
or memory stick into the default Voice folder of the Sony Voice Editor. Once new 
folders/files are loaded into the Voice Editor, select the menu item File / Save as VOICE 
Folder. Browse to a folder that you have created for docking recordings. Select WAV file (16 
bit) under Save as Type. Click on save.
Once this process is complete, use the Express Scribe Dock Audio File Transfer method 

and point to the same folder that you saved to.
Dock - Audio Cable Method 
This method must be used if you are using an analog microcassette recorder or the digital 
handheld you have uses a non-standard proprietary format.
The process is simply playing back the recording into the computer. This can be more effective 
then it might sound because with a duplex sound card and accurate threshold detect levels, 
the transfer can happen automatically in the background while you continue to type.
In order to transfer a recording from a portable dictaphone or notetaker into Express Scribe, 
you need to connect a lead between the Ear socket on the portable and the Line-In socket of 
the sound card. You should be able to purchase a suitable lead from an electronics store for 
under $10.
Connection Settings  
Sound Record Device 
If you have more than 1 sound card in your computer, select the sound card connected to your 
portable in this pull down list.
Audio Input Channel 
This should usually be "Line" or "Line-In" for the transfer connection.
Record Volume Level 
Adjust the record volume so that the level display just touches into the red in the louder peaks 
during dictation.
Use level activated recording  
Activate Level  
Transfer will automatically start and stop using the level of the incoming audio. The default 
setting is -15dB. If recording starts too early or does not automatically stop at the end of the 
tape, increase this level. If recording does not start correctly, or truncates the end of a 
recording, reduce this level. You should correctly adjust the record volume level before you 
adjust the activate level.
If you want to record manually you can untick the "Use level activated recording" box.
Transfer at high speed 
If your recorder is capable of high speed transfer, you can speed up the transfer of long 
recordings by enabling "Transfer at high speed" and setting the transfer speed to the same as 
the recorder's playback speed. If your recorder has no high speed transfer mode, or the 
incorrect speed is set, the resulting dictation will sound incorrect. Note also that the quality of 
recordings transferred at normal speed is generally better than recordings transferred at high 
speed. 
Restart 
If recording has started incorrectly, click the restart button to start recording from the start of 
the Tape.
Done  
When transfer is complete, click the Done button.
You should not need to do this manually. The Transfer Window should automatically close 15 
seconds after the end of the recording. So long as your record volume and activate levels are 
set correctly, you should be able to start recording and "walk away".
Duplex Operation 
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With most sound cards you can "Dock" recordings while you continue to use Express Scribe to 
play other recordings. To do this open the Dock window and start recording as described 
above. Do not click Done - simply click on the title bar of Express Scribe to give it focus. If you 
continue to hear the recording from the portable then click on the speaker icon on the task bar 
and close the Line-In channel. You can then use Express Scribe as normal while it records in 
the background. You might need to adjust the System Volume Control so that the line in is not 
selected for the playback volume.
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Special Audio Processes
These processes are accessed by selecting the 'Special Audio Processes' option from Express 
Scribe's File menu.
Background Noise Reduction:  
When you selecting this audio process, a floor threshold reading is taken from the audio file, 
and all sound below that value is removed. This can be helpful if the recorded ambient 
background noise is making it difficult to make out the voice on the recording. However, this 
feature will not be useful if the recording was made in an environment with high background 
noise, as Express Scribe will be unable to differentiate between the background sounds and 
the voice dictating.
Extra Volume Boost: (Loudness, Volume, Amplitude, Level and Gain) 
The terms loudness, volume, amplitude and level mean roughly the same thing. The more 
volume a sound is given the more power has been used to create it and the louder it sounds. 
Sometimes when you receive a dictation, the recording may not be loud enough and will 
require more volume than the main controls give you. Selecting this audio process will increase 
the volume of the entire file by 10%.
High Pass Filter:  
When this audio process is selected, only those frequencies in the audio file above 450Hz are 
kept. Using the high pass filter can help clean up the audio file to make the dictation more 
intelligible, especially if the original recording sounds muddy.
Undo:  
This will undo all changes made since Express Scribe or that particular file was loaded.
Note: If you wish to edit the parameters of any of the above settings you will need to use 
another of our products: Wavepad. 
Wavepad comes in a free downloadable version along with a trial masters edition which you 
find at www.nch.com.au/wavepad 
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Advanced Email Settings
You can set up the way Express Scribe dispatches email using the Advanced Email Settings 
dialog box.
The Advanced Email Settings can be opened by clicking on the "Email Settings" button from 
Dispatch.
Mail Delivery Type: MAPI or SMTP 
Express Scribe can send email in two ways MAPI or internal SMTP.
By default Express Scribe uses the MAPI system to send email using your existing email 
software (Eudora, Netscape Mail, Lotus Notes, Outlook, Mail, Thunderbird, etc.). To use this 
you must have email software installed and set as the "default MAPI server". The advantage of 
this system is that your email software manages the email. However, there can be some 
problems when using Outlook (it keeps prompting for user input). If you have MAPI problems, 
try the alternative internal SMTP. 
If you select the "Internal Simple SMTP" option, email is sent directly by Express Scribe. You 
must enter the SMTP mailhost used by your ISP for sending of mail (call them if you do not 
know it) and your email return address.
Please refer to Problems when sending email using our software for trouble-shooting 
information. 
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Recover Old Dictation(s)
The Recover Old Dictations dialog can be viewed by pressing Ctrl+R, or clicking the Recover 
Old Dictations button in the secondary toolbar. Dictations that have been dispatched or marked 
as Done will appear in this dialog. Old dictations are automatically deleted after 1 month, 
unless the setting is changed (see Options ~ Disk Usage). 
Play 

Preview dictations to verify which one you want to work with. 
Recover 
Move the selected dictation(s) back to the dictation list in the main window. 
Delete 
Permanently deletes the selected dictation(s). Deleted dictations cannot be recovered, so 
use with caution. 
Find  
If the list of dictations in the "Recover Old Dictation(s)" is very long, you can search by 
Dictation Name, Date, Sender or Notes to quickly highlight the relevant dictation. 
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Find A Dictation
To quickly find a dictation, press Ctrl+F to bring up the 'Find a Dictation' dialog. You may 
search terms contained in any column in Express Scribe's main window. First, select the 
column you want to search, then type the search term in the 'Text to Find' box. Note that all 
searches are case sensitive. Press Ctrl+G to find the next dictation matching the same search 
term. 
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Software Development Kit
For information on programmatically integrating Express Scribe as part of other software or a 
larger dictation system, please refer to the Software Development Kit  online documentation. 
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.
There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 

28



Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.
2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.
3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.
4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.
5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.
6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.
7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.
9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.
A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.
A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.
B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.
D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give Express Scribe authorization to upload to Google Drive and/or 
YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize Express Scribe to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in Express Scribe. 
5. Click Ready to confirm that authorization is complete. 
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Controllers - Controllers ~ Overview
About Foot Pedal Controllers  

Many actions in Express Scribe can be controlled by a foot pedal controller. Each button or 
pedal on the controller can be mapped to a command that is triggered when that button or 
pedal is pressed. 
Foot pedal controllers allow you to trigger commands without removing your hands from the 
keyboard or mouse, in a more intuitive way than keyboard short-cuts or hot-keys. 
See Controllers ~ Compatible Controllers for a list of controllers that are compatible with 
Express Scribe. 
Button or pedal presses on controllers are detected regardless of whether or not Express 
Scribe is in the foreground or has focus. The controller will continue to function even when 
Express Scribe is minimized, or while using a document in another application. 
Active Controller 
The "active controller" is the controller that has been configured for use.
See Foot Pedal and Hand-Held Controller Setup Guide  and Options ~ Control for 
information about configuring the active controller. 
Note that if the active controller is unplugged and moved to a different port, it will no longer 
be detected as the active controller. You must either reconnect the controller to the original 
port, or run the Controller setup wizard again. 
Controller Status 
An icon representing the status of the active controller appears on the right-hand side of the 
status bar. The icon has four possible states: 

● Black icon, green dot: The active controller is attached and configured correctly.
● Black icon, orange dot: The active controller is configured, but is not attached.
● Black icon, red dot: The active controller is not configured correctly, or an error has 

occurred.
● Gray icon, no dot: The controller feature is disabled
Hover the mouse cursor on top of the status icon for a text description of the controller 

status. 
If the controller feature is enabled but no active controller is configured, a message may 
appear in the notification tray area when you attach a plug and play controller. Click on this 
message to launch the Controller setup wizard and configure it as the active controller. 
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Controllers - Controllers ~ Compatible Controllers
See Controllers ~ Overview for an overview of controlling Express Scribe with a hand-held or 
foot pedal controller. 
Recommended Controllers 

The following controllers are known to be compatible with Express Scribe, and technical 
support purchased for Express Scribe covers assistance in configuring them. 
Visit our website for purchasing information. 
Controller Image  Description  Supported 

Operating 
Systems 

Software License 

AltoEdge USB 
Foot Pedal

 USB foot pedal 
with three pedals

Microsoft 
Windows, Mac OS 
X

Not required

Wireless 
Transcription Foot 
Pedal

 Wireless foot pedal 
with three pedals

Microsoft 
Windows, Mac OS 
X

Required
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VEC Infinity 
IN-USB-1 / 
IN-USB-2

USB foot pedal 
with three pedals

Microsoft 
Windows, Mac OS 
X

Required

vPedal vP-1 (USB)  USB foot pedal 
with three pedals

Microsoft 
Windows, Mac OS 
X

Required
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vPedal vP-4 MKII 
Wireless Footpedal

Wireless Bluetooth 
foot pedal with 
three pedals

Microsoft 
Windows, Mac OS 
X

Required

 
Legacy Controllers 

The following controllers are known to be compatible with Express Scribe, and technical 
support purchased for Express Scribe covers assistance in configuring them. However, if you 
are considering purchasing a new controller, prefer one of the "Recommended Controllers", 
listed above. 
Controller Description  Supported Operating 

Systems 
Software License 

VEC Infinity IN-DB9 9 pin serial port foot 
pedal with three pedals

Microsoft Windows, Mac 
OS X

Required

vPedal vP-1 (Serial) 9 pin serial port foot 
pedal with three pedals

Microsoft Windows, Mac 
OS X

Required

 
Other Controllers  

The following controllers may be compatible with Express Scribe, however some features may 
not work. NCH Software offers no technical support for these controllers. 
Controller Description  Supported Operating 

Systems 
Software License 

Olympus Foot Switch 
RS-27 (USB)

USB foot pedal with 
three pedals

Microsoft Windows, Mac 
OS X

Required

Philips Foot Control 
2320

USB foot pedal with 
three pedals

Microsoft Windows, Mac 
OS X

Required

Generic game controller Any game controller, 
with one or more 
buttons, which has been 
installed and configured 
in Windows ("Control 
Panel" -> "Game 
Controllers")

Microsoft Windows Required

Generic serial port 
device
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 Some controllers which 
attach to the serial port 
but are not listed above 
in "Recommended 
Controllers" or "Legacy 
Controllers", can be 
configured as generic 
serial port controllers 

Microsoft Windows Required

 
Custom Drivers  

If Express Scribe is running under Microsoft Windows and your controller is not listed as 
compatible, you may be still be able to use it by writing a custom driver. NCH Software offers 
no technical support for custom drivers. 
To do this, you will need: 

● Computer programming experience.
● Documentation, from the controller manufacturer, of the API used to interface with the 

controller.
A software license is required to use custom drivers.

Connectors 
Controllers can use any one of the following connectors:
Port Plug Supported Operating 

Systems 
Notes  

USB Usually USB-A  Microsoft Windows, 
Mac OS X 

Serial 9 pin DE-9 or 25 pin 
DB-25

Microsoft Windows

Game 15 pin DA-15 Microsoft Windows Microsoft no longer 
supports the game port 
in Windows Vista or 
later.
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Options - Options ~ Playback
Playback 
Sound Device  
If you have more than one sound card installed, use this pulldown list to select the device for 
playback.
Volume Level  
This is the volume setting for playback. It can also be adjusted on the main window of Express 
Scribe.
Volume Auto-Adjust (Range Compression) 
Dynamic range compression amplifies quiet passages in the audio without making loud 
passages any louder. The Weak setting applies the least amplification and sounds more like 
the original recording, while the Strong setting applies the most amplification. 
Default Playback Speed 
You can adjust the slow (F11/F12) and fast (F3) playback speeds. The speeds are represented 
as a percent of normal speed so 50% is half speed and 200% is double speed. Recommended 
settings are slow 50% (minimum 25%, maximum 100%) and fast 150% (minimum 100%, 
maximum 300%).
The speed of play current speed (F9) is controlled using the speed control on the main window.
Clarity low frequency cutoff method (Low Frequency Cut Filter) 
Express Scribe uses a Low Frequency Cut Filter which can improve the clarity of poor quality 
recordings. The clarity can be controlled by setting the frequency cutoff point.
For no frequency filter set the control to None. For a mid level frequency filter use High or Low 
Bass Filtering or for very poor quality recordings use the 1500Hz strong filter. The default 
setting is for no filter: Full Bass (0Hz).
Auto Backstep on Stop 
If you stop playback and start again later, Express Scribe can be set to 'back-step' so that you 
hear a short part of where you were before you stopped. This back step time can be adjusted 
(in ms), so if you want the dictation to be wound back one and a half seconds enter a value of 
'1500'. To turn the back step off, enter 0. The maximum is 60000ms.
Rewind and Fast-Forward 
The rewind and fast-forward mode can either be Increasing Speed (default) or Constant 
Speed. In both cases, Express Scribe first takes a preset step back or forward (default 500ms, 
maximum 60000ms) then starts at the preset speed (default 150%, maximum 1000%). If 
Increasing Speed mode is selected, as you hold down rewind or fast-forward the speed 
increases over 6 seconds to a maximum speed specified (default 800%, maximum 1000%).
When a dictation finishes playing  

● Play a sound: 
If you tick this option and browse to locate a WAV file, that file will be played whenever 
a dictation finishes playing. Useful sounds files can usually be found in the 
C:\Windows\Media folder. 
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Options - Options ~ System-Wide Hot-Keys
Please refer to About System-Wide Hot-Keys for information on how to use hot-keys and how 
to change them. 
Please refer to Keyboard Reference for a list of default system-wide hot-keys. 
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Options - Options ~ Incoming
Incoming Recordings  

Configure incoming recording sources to simplify and automate the process of checking for 
and loading new dictations. Set up a new incoming source by clicking the Add button. See 
the Options ~ Incoming ~ Incoming Source Properties section for more information on 
configuring recording sources. 
An existing incoming source may have its details modified by clicking the Properties button 
to open its Incoming Source Properties dialog, and then changing the required settings. See 
the Options ~ Incoming ~ Incoming Source Properties section for more information on 
configuring recording sources. 
To delete an incoming source from the list, highlight it in the Incoming Recordings list and 
then click the Remove button.
When a new dictation arrives: 
● Perform special process: 

These audio processes can be used to improve the quality of the received audio and 
make it easier to understand the speaker. Available processes include "Background 
Noise Reduction", "Extra Volume Boost", and "High Pass Filter". 

● Play a sound: 
If you tick this option and browse to locate a WAV file, that file will be played whenever a 
new file arrives to let you know you have a new dictation. Useful sounds files can 
usually be found in the C:\Windows\Media folder. 

● Display a bubble tip: 
You can set whether you want a bubble tip to appear each time you receive a new 
dictation. 
Note: On Linux, this option is only available if you have the libnotify library installed. 

● Select it (unless another dictation is playing): 
When checked, the dictation that has arrived will be selected in the dictation list when it 
finishes loading. If another dictation is playing when the new dictation finishes loading 
then the selection remains unchanged. 

Set User's Decryption Key 
Express Dictate, Pocket Dictate, DialDictate and WebDictate can encrypt the recordings prior 
to transmission to protect security and privacy. If this has been done, you must enter the same 
key in Express Scribe to decrypt the audio.
The key is based on the user id of the sender (obtained when you register Express Dictate or 
DialDictate). If you have not yet registered, use the id 0.
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Options - Options ~ Incoming ~ Incoming Source 
Properties
This dialog allows you to configure the automation of incoming recording files. The dialog is 
found from Options -> Incoming tab and then by clicking the Add (for a new receiving 
configuration) or Properties (to configure an existing receiving configuration) buttons.
Receive Method Tab  

Receive Method  
● Express Delegate 

Select this option to load dictations from an Express Delegate (v 4.00 or above) 
dictation workflow management server. Express Delegate is a dedicated dictation 
workflow management server from NCH Software. 

Express Delegate Options
The Express Delegate Server can be a computer that is accessible across a LAN 
(local area network) or the Internet. The Express Delegate administrator will need 
to create an account before you can logon to the server. Please consult the 
Express Delegate help for more information on installing Express Delegate, 
configuring the server, and creating user accounts.
You'll need to know the Server and Logon details for the Express Delegate server 
you are connecting to: 

Server 
● Address: 

eg. server.company.com 
● Port: 

The server port number. 
● Secure connection (SSL/TLS): 

Check this check-box to encrypt data transfers to and from the server. 
Logon  
● Email address / password: 

The Express Delegate user account logon email and password. Please 
consult the Express Delegate help for information about how to reset your 
password if you have lost it. 

Test connection:  
Click to attempt a connection to the server using the current server and logon 
details. If the connection is successful then details of the server will also be 
shown. 

● FTP:  
Select this option to load dictations from an FTP (File Transfer Protocol) server. Note 
that you must have your own directory on this server. You do not need to host your 
own server - almost all ISP web hosting services offer FTP access which is suitable 
and very affordable, and the server can be located anywhere in the world. NCH 
Software provides a list of recommended FTP hosting services here. 
Warning: Dictations will be automatically deleted from the FTP server once they are 
loaded. 

FTP Options: 
You'll need to know the server and logon details for the server you are connecting 
to: 

Server 
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● Address: 
eg. ftp.company.com (or ftp.company.com:12345 to specify a non-default 
port number). 

● Secure connection (FTPES) 
Check this check-box to encrypt data transfers to and from the server, if 
the server is capable of doing so. 

Logon  
● Type: 

Select whether to log on using a user account or anonymously. 
● User name / password (if logon type is not anonymous): 

The FTP account name and password. 
Folder: 
eg. /Name/Dictations 
A sub-folder of the default FTP server folder. 
Test connection:  
Click to attempt a connection to the server using the current server and logon 
details. 

● Local Folder: 
Select this option to load dictations from a shared drive or folder on a LAN (local area 
network), or a folder on your local machine. 
Warning: Dictations will be automatically deleted from the source drive or folder once 
they are loaded.  

Local Folder Options  
● Source folder or drive: 

e.g., H:\Shared Folders\Typing\Your Folder\\Server\Folder The source folder 
may be either a shared drive or folder on a LAN (local area network), or a 
folder on your local machine. When using a network drive or folder, please 
ensure that share permissions have been set appropriately. 
The source folder may be set to the local folder where your email program 
stores attachments if you want to automatically load dictations from received 
emails.

Loading Mode Tab  
The loading mode determines when this incoming source will be checked for new dictations, 
and how many dictations to load if more than one is found. 
● Manual - One at a time: 

The incoming source will be checked when the "Sync" button or menu item is clicked. If 
multiple new dictations are found, only the one with the highest priority will be loaded. 

● Manual - All files: 
The incoming source will be checked when the "Sync" button or menu item is clicked. 
All new dictations that are found will be loaded. 

● Automatic - All files: 
The incoming source will be checked automatically at the interval specified in "Check 
Interval (minutes)". All new dictations that are found will be loaded. 

Check interval (min) 
This value specifies the time interval in minutes between automatic checks of the incoming 
source for new dictations. (If manual loading is selected, check interval is disabled.)
File Types Tab 

Check the checkboxes next to the file extensions that you want to load from this incoming 
source. 
Note: No file extension checkboxes will be displayed if the Receive Method being used is 
Express Delegate 
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Options - Options ~ File Types
Set Default RAW/VOX Settings.. 
Please see Codec Settings for more information. 
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Options - Options ~ Speech to Text
Once you have setup Express Scribe for Speech to Text, when you load a file it will process 
the file in the background and then include the full text in the Notes box. Even if your computer 
is fast, this can take some time (even longer than the recording itself) so this function works 
ideally when you have a queue of typing work. However, because the speech recognition runs 
in the background, you can start transcription immediately.
You should not be too excited by speech to text. It will be many years before machines will be 
able to transcribe accurately. At the moment, even a well trained engine will offer at best 
around 90% accuracy. It is our concept that you will use this feature as a tool to provide you 
with draft text which you can play through at a faster speed and correct or re-format.
Training is essential to get reasonable text to speech. You must "train" the engine to recognize 
each voice that you are going to use. The training function is managed by your speech 
recognition software, not Express Scribe. Please refer to your speech engine manual for more 
information.
Express Scribe automatically matches each dictation file with a trained speaker using the 
Express Dictate (or DialDictate) ID of the sender. This ID is obtained when they register their 
software (all unregistered users, WAV files and docked recordings are considered to be ID 0). 
After you train a Speaker to learn a User's voice, Express Scribe can set that speaker to run 
everytime that User sends you a file. You do this in the "User-specific profiles" section of the 
Options->Text to Speech tab.
Setup for Speech to Text 
1. Open the Options dialog and select the Speech to Text tab.
2. Click "Enable speech recognition".
3. Select the speech recognition engine from the Engine drop-down list. If you do not see any 

engines in the pull-down list, then you have not fully installed your speech recognition 
software or it is not SAPI compliant.

4. Select a speech profile from the Default profile drop-down list. This is the profile that will be 
used for any dictations received from users who are not listed in "User-specific profiles".

5. Get each user to train the engine so it can recognize them. They do that using your speech 
recognition software. Please refer to the manual provided with your speech recognition 
software. With most engines they can train the speech recognition engine using an other 
PC and then export the training file to your system.

6. For each user who has completed the training, add their User ID and speaker Profile to the 
"User-specific profiles" list. If they are registered users of Express Dictate or DialDictate, 
use the ID that they obtained when they registered their software. User ID 0 for all 
unregistered users, WAV files and docked recordings.

Note: When opening the Speech to Text Options tab, or changing the selected Engine, the 
"Retrieving profiles" dialog may be displayed for some time. 
When your next dictation is loaded, Express Scribe will run the speech engine in the 
background. When complete, it will "paste" the text into the Notes box.
Please be patient. The process can take some time (even longer than the recording itself). 
Thus the function is ideal when you have a queue of items. But remember that you can start 
transcribing immediately.
Please note that the Speech to Text process will only happen when a dictation is first loaded. If 
you run Express Scribe with an already loaded dictation the recognition process will not run.
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Options - Options ~ Disk Usage
Delete old 'done' files after number of days  
If your hard drive is running low, you can set or reduce the number of days after which Express 
Scribe will automatically delete 'done' recordings. Set this to 0 if you do not want files to be 
deleted.
Warn me when my hard drive space is below (MB) 
This setting will set a check when loading files, or when starting Express Scribe, to display a 
warning when the hard drive free space falls below the number of MB specified. Once it goes 
below this amount Express Scribe will no longer be able to load files.
Data Folder  
This setting determines where Express Scribe stores its data files. You may need to change 
this setting if you have multiple hard disks (or your hard disk is partitioned) and the default 
folder is on a small disk. The default setting is suitable for most users.
Warning: 
● Avoid setting the data folder to a folder on a removable disk.
● Avoid setting the data folder to a network location.
● Data in the current data folder (such as any currently loaded dictations) will no longer be 

visible to Express Scribe if the data folder is modified.
Use the Set to Default button to reset the data folder to its default path.
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Options - Options ~ Display
Time Mode The time can be displayed throughout Express Scribe in one of the following 
modes: 

● Time elapsed  
The relative time from the beginning of the recording to the current playback position. 

● Time remaining 
The relative time from the current playback position to the end of the recording. 

● Recording time 
The absolute, real time when the current playback position was actually being recorded. 
This mode is particularly useful if you are transcribing material recorded with 
MSRS - Multi-Channel Courtroom or Conference Recorder. 

Time Format Display the playback position or recording duration using one of the following 
formats:

● m:ss 
Minutes and seconds. 

● m:ss.t 
Minutes, seconds, and tenths of seconds. 

● h:mm:ss  
Hours, minutes, and seconds. 

● h:mm:ss.t 
Hours, minutes, seconds, and tenths of seconds. 

● mmm:ss 
Minutes (with leading zeros) and seconds. 

● mmm:ss.t  
Minutes (with leading zeros), seconds, and tenths of seconds. 

● hh:mm:ss 
Hours (with leading zero), minutes, and seconds. 

● hh:mm:ss.t  
Hours (with leading zero), minutes, seconds, and tenths of seconds. 

Prefix / Suffix This prefix and suffix will be affixed to the current playback position when it's 
inserted into the dictation notes (Notes -> Insert -> Time), or copied to the clipboard (using the 
"Copy Time" command in Options -> Hot-Keys). 
e.g. Set prefix to "[" and suffix to "]" to give "[0:12:34.5]". 
Additional Columns 
You can configure up to two custom columns to display tag  values in the dictation list on the 
main window. You must specify the name of the tag, and a label for the column. 
e.g. If the notes contained a tag <caseno>12345</caseno>, then "XML Tag" would be 
"caseno", and "Column Label" could be "Case". The value "12345" would then be displayed in 
the row corresponding to that dictation. 
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Options - Options ~ Other
Use a word processor document based on this file  
If you are using a word processor to type the received dictations, Express Scribe can create a 
new document for each recording when you press Ctrl+U, or click the word processor icon in 
the secondary toolbar on the main screen. When it creates the new document, it copies a base 
word processor file (that might, for example, contain your standard template, etc.). If you want 
to use the Ctrl+U option with Express Scribe, you should create and select a base document 
file for Express Scribe to copy. 
Add
You can add multiple base templates to use and select which one to use at the time you create 
the document.
Remove
If you no longer wish to use a particular template, you can remove it from the list with the 
Remove button.
Set to Default
You can change which document is automatically chosen when you press the Ctrl+U shortcut 
by selecting it and pressing the Set to Default button.
Advanced Email Dispatch Settings 
Use this button to open Advanced Email Dispatch Settings . 
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Options - Options ~ Control
See Controllers ~ Overview for an overview of controlling Express Scribe with a foot pedal 
controller. 
Enable foot pedal controller  
Check this box if you intend to use a controller. 
Controller setup wizard 
Run this wizard to select and configure the active controller. See 
Foot Pedal and Hand-Held Controller Setup Guide  for details. 
Active controller  
Shows the type of controller that is configured, if any, and it's status. 

Properties 
Shows static properties of the active device, such as the company, model, and interface. 
Also allows changes to some configuration options, such as which port to use for a 
controller that connects to a serial port. 
Command map / test 
Shows a list of the active controller's buttons or pedals. 

● The first column shows the name of the button or pedal. 
● The second column shows the Express Scribe command that will be run when this 

button or pedal is pressed. 
Commands marked with a "*" are affected by the "Tap lock" option, below. 

● The third column is used to test the controller configuration by showing if each button 
or pedal is currently pressed. 

Click "Change a Command" to bring up a dialog that allows you to change the command 
performed by a button or pedal. 
Click "Reset to default commands" to reset the command mappings for each button or 
pedal to their original state. 
Tap lock 

Any command marked with a "*" in the "Command map / test" dialog can be run for variable 
duration. The command will start when the mapped button or pedal is pressed. Change the tap 
lock options to configure when the command will stop. 

● When tap lock is disabled, the command will always stop when the button or pedal is 
released. 

● When tap lock is enabled: 
● If unlock time-out is disabled: The command will always continue after the button 

or pedal is released, and will stop on the next press. 
● If unlock time-out is enabled: If the button or pedal is released quickly then the 

command will continue until the next press. However, if the button or pedal is 
held longer than the time-out then tap lock is ignored and the command will stop 
when the button or pedal is released. 
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Screen References - Custom Resolution
This dialog allows you to set up the resolution for your video during saving. To set a custom 
resolution, click the Save button on the toolbar and select the Disc: Make Data Disc, 
Computer/Data, Portable Device, Image Sequence, or Stereoscopic 3D options. From the 
Resolution drop menu, select Custom.
In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
If Keep aspect ratio checkbox is available, you can check it to retain the same aspect ratio 
when changing the width or height. 
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Screen References - Custom Resolution 
(360-Degree Video)
This dialog allows you to set up the resolution for your 360-degree video during saving. To set 
a custom resolution, click the Save button on the toolbar and select the 360 Video File option. 
From the Resolution drop menu, select Custom.
In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
The width must be exactly double the height for 360-degree videos.
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Screen References - Custom Frame Rate
This dialog allows you to set up the frame rate (number of frames per second) for your video. 
To set a custom frame rate, click the Save button on the toolbar and select either of the Disc: 
Make Data Disc, Computer/Data, Portable Device, or Stereoscopic 3D options. From the 
Frame Rate drop menu, select Custom.
In the Custom Frame Rate dialog that opens, input the frame rate and click OK.
The default frame rate is Variable Frame Rate (VFR)  but the dialog allows the user to select C
onstant Frame Rate (CFR)  by selecting the Constant frame rate checkbox.
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Screen References - Detected Format
This dialog shows you the detected format of the video sequence during the saving process. 
To detect the format of your video, click the Export Video button on the Home tab bar and 
select either of the following options: Video File, 3D Video File, Portable Video, Lossless 
Video, DVD Movie Disc, DVD Data Disc, Image Sequence, YouTube, Flickr, Dropbox, Google 
Drive, OneDrive, or Vimeo.
Click the Detect button next to the Preset field. Detect will adjust the video output resolution 
format based on your monitor screen size.
If you want to use a different format you can select the format from the Preset drop-down list.
Click OK to use the selected format as the output format.
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Screen References - DVD Bitrate Settings
This dialog allows you to specify bitrate for your DVD video. To open this dialog, click the Save 
icon in the toolbar and select the Disc save option and click the Make DVD Movie option. Click 
the Advanced button to open the DVD Bitrate Settings dialog.
The default option is to calculate the bitrate automatically. To set the bitrate manually, select 
the manual option and adjust the video and audio bitrates.
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